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What is the ALTO Filestore?
http://alto.arts.ac.uk/filestore

As the name suggests it is a place to store and share files, it is great for storing and sharing finished
works and your own work in progress too, it’s like having your own personal long-term digital library
and archive, where you are in control. In fact, the whole design of this software tool is based on the
metaphor of a library, with the use of catalogue information to manage the various resources that
users deposit in the system. The software used is called EdShare and is a variant of the popular
research repository software package Eprints from the University of Southampton. A service like
Filestore is a relatively new experience in higher education and we expect it and the wider ALTO
system to evolve and adapt over time as staff and students use it. This Filestore system is a
powerful one that provides a great deal of control and functionality to help you manage and share
your resources. You can choose how you want to use the system - either in a lightweight way or to
become a ‘power user’. Don’t be put off by the length of this manual, it’s long because it sets out to
cover all the different aspects of the system.

The system allows UAL staff (staff only at the moment) to deposit a wide range of digital resources
into the system including Word and PDF files, images, animations, audio and video as well as
‘bundles’ of file collected together as zip files. Note, both staff and students can also use the
Filestore sister service ProcessArts (http://process.arts.ac.uk/) which provides a more informal Web
2.0 style ‘open studio’ space for sharing and discussing practice.

UAL staff Filestore users can also create catalogue records that link to external web resources such;
as newspaper sites, the national UK learning resource collection at Jorum (www.jorum.ac.uk), or
any website such as YouTube. Another powerful feature of the system is that users can select
(bookmark) resources and bring them together into virtual collections and present them with
additional notes (a kind of ‘library playlist’). This can be useful to create new learning resources
from existing content.

Filestore and Levels of Sharing
You can choose to use the ALTO Filestore as a personal

o Sl space to organize your own content, or share just with
e ~ selected UAL staff, or the whole of the UAL, or share
E®. Filestore with the world. Access is via your standard UAL login.

ALTO is the place where staff and students from across
the University of the Arts L 0 loaming
resources with the global

You have a high degree of control over who and how
you share your resources with — these are your options
in increasing degrees of ‘openess’:

1. ‘Just for me’ — Your own personal filestore
accessible from anywhere at anytime.
2. ‘Selected Colleagues Only’ — Choose named
e members of the UAL to share your resources with,
= @ great for project work.
3. ‘Only Inside the UAL’ — Access is restricted to
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student and staff members of the UAL only and use is governed by the UAL Commons
licence
a. Option to only share with UAL staff
4. ‘Open to the World’ — Free to use by anyone on the open web, use is governed by the
Creative Commons licence that you choose

How the Filestore Relates to the Rest of the UAL ALTO System

When the ALTO project started at the UAL we decided, learning from hard experience elsewhere,
that just providing a digital library system (no matter how good) would not be enough. It was going
to be crucial to also support the social collaborative and communicative activities relating to the
design, development, sharing and reuse of learning resources. As a result we came up with the idea
of an ‘ecosystem’ made up of technical services, policy development and online and offline social
spaces that work together to deliver a growing community of sharing across the UAL.

The original ALTO project spotted an existing UAL initiative called Process.Arts, which was
successfully fulfilling the online social space function we needed, so we invested a small amount of
money in upgrading the site — this has since been growing rapidly and has been nominated for
several awards. Policy development came in the form of the UAL legal department accepting the
use of Creative Commons licences on the sites — a big step forwards. Recognising that lots of
existing open content is already on UAL websites we developed the simple concept of having
partner sites who affiliate to ALTO. This is done by agreeing to licence the contents of the site under
a Creative Commons licence, and placing an ALTO logo on the site that links to the Filestore. As part
of the arrangement we create an entry in the Filestore catalogue that ‘points’ to the site and helps
search engines drive new traffic to the site.

The Other Parts of the ALTO System

Process.Arts: http://process.arts.ac.uk/

.. Thisis a more informal space that is ideal for showing
———— your work in progress, using rich media, discussion, and
feaued memmee | COllaboration with others, it integrates well with

common Web 2.0 tools. Access is via your standard UAL
login; this site is constantly developing and growing.
Staff and students at the UAL are using this to share
their practice and processes, and discuss and collaborate
s it e LU0 on topics and projects. This site is the equivalent of an
- ":p”'“p E . open online studio or workshop where artists, makers,
J ) e teachers and students at the UAL can show and discuss
what they are involved in. It also provides a great way

S for people from outside the UAL to see what goes on

e TR o s Qbch Chat Qs here and helps them to identify courses and colleges
they might be interested in studymg at. After being nominated for national and international
awards from the open educational community this site is being upgraded with extra functionality by
ALTO. This site is currently the ‘proof of concept’ for a (successful) bid for funding from JISC to
develop a pilot service for the UK Art & Design HE sector.
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ALTO Partner Sites

Already have your work on the web at the UAL? —
Become an Affiliate of ALTO. This is a great solution for
Colleges and Projects that have or are planning to
create websites that are open to the web and want to
get the benefits of associating themselves with the
worldwide open education movement. This is
intended to be a low-threshold way of getting
involved. Becoming an affiliate is conditional on
accepting:

5 | NEW ARRIVALS | GETTING AROUND | GETTING BY | STUDY TIPS | TALKING HeAos

* The ALTO Terms and Conditions and the ALTO
Notice and Takedown policy
* Licence your content under a Creative
Commons Licence and placing a CC logo and copyright statement on your home page
together with the CC html licence code
* Place an ALTO logo on your home page that contains a link to an entry in the ALTO Filestore
describing your site — this has the benefit of being ‘search engine friendly and drives extra
traffic to your site, especially from the open educational community

If you manage a web site at the UAL and would like to make it an open educational resource by
becoming an ALTO Affiliate then contact the ALTO administrator to discuss how to do this and the
benefits to be gained. ALTO Administrator Email: alto@arts.ac.uk

How to Use this Guide

The guide is written in such a way that it assumes you read it in the order it is written, after that you
can use it as a quick reference. It will probably be best if you print this guide and refer to it as you
work through using the Filestore. The illustrations are collected together in a separate file (to make
future updates easier) so it will make sense to have them printed separately and refer to them. If
you are using the online version of the guide in PDF format it will be easier to have the guide open
in two windows — one for the text and one for the illustrations.

Authors: The ALTO Project at the University of the Arts London. 4
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Filestore Guide — for users who are not logged in
This part of the guide shows you what a visitor to the system will see and how your resources will
look to them. The home page is shown in illustration 1

Find and Search

If you want to carry out a quick search of the Filestore, then choose the Quick Search box at the top
right of the page, type in your search terms and then press the return button on the keyboard (see
lllustration 1). You can also perform an advanced search by clicking on the Advanced Search link at
the top right of the home page (see lllustration 1), that allows you to specify what kind of search
terms you want to use —its very powerful. You can order the search results by Year, Author Name
or by Title. You can also export your search results in a number of formats — this can be very handy
for citing resources from the collection using a range of different formats (tip - try the ASCII or
HTML Citation options). The export results appear in a new browser window from where you can
copy and paste them into other applications such as a word processor. The large orange ‘Find’
button on the home page and the ‘Find’ tab at the top of the home page will both display a ‘Simple
Search’ page, which has the option to change to an advanced search.

Sharing

The large green ‘Share’ button on the homepage brings up an information page about to sharing
your work and things to consider as well as the different options that the ALTO system provides for
sharing.

Viewing Resources — Not logged in
If you browse or search the system you will be able to view the resources that you are allowed to
access and their catalogue information (metadata). lllustration 1A shows what a non-logged in user
will see when they view a resource. The resource shown is a training resource. This particular
resource contains 4 files:

1. JPEG image file

2. Web link

3. Zipfile

4. Word document
You will notice that the files are shown as thumbnails beneath a preview window. If you click on a
thumbnail the contents of the file will be shown in the preview window, in this case the web link to
a website has been selected and it is being displayed. If a Word, PDF or image document is selected
it will be shown in the preview window. A user has the option to click on a web link under the
bottom right hand side of the preview window. This web link will either give the user the option to
view the website in another browser window or if a file is selected to download the file.

Down the right hand side of the page the catalogue (metadata) information about the resource is
displayed, the text in blue being web links. Your will also see here that there is a heading ‘Toolbox’
for a non logged in user the only option here is to download the resource as a zip file.

Along the bottom of the page is a heading called Comments and Notes with two tabs. You have to
be logged in to create a Comment or a Note. A Comment about a resource will be publicly visible to
all users and a Note will only be available to the person who wrote it.

Authors: The ALTO Project at the University of the Arts London. 5
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Web 2.0 Features

In common with many other web services the Filestore provides the ability for visitors to your
resources to share links to them and comment about them. Often referred to as ‘Web 2.0’ these
features merely mean that systems are designed to encourage users and visitors to communicate
and collaborate around online collections of content. While browsing and

searching in the Filestore you will see at the top left of the page these £l » 0
symbols. These provide links to various services that enable a user to

comment on the content in the Filestore and create links to it from external web services like
Facebook, Twitter and Blogs etc.

Once you start browsing and searching in the system and resources

are presented for viewing, then you will see another set of tools £ £ £
towards the top right of the page that look like these. These are

syndication tools using common formats that enable users to share the displayed content from
Filestore on other web sites in a number of ways. One of the most popular applications for these
tools is to use them to embed ‘feeds’ on other websites that provide a summary of the content and
can change over time as the content is updated. If you would like to know what information these
tools will collect just click on one of the logos. If you look at lllustration 1 you will see that the
Filestore homepage itself has several of these ‘feeds’ that display a summary of information from
other websites.

Some other Web 2.0 features are only available for logged in users, for instance you have to be
logged in to create comments or notes about a resource

Navigating Back to the ALTO System Home Page

The Filestore is a self-contained repository for learning resources within the wider ALTO system and
in web terms is ‘sticky’ i.e. its design concept likes to keep users inside its digital library. If you need
to return to the home page of the wider ALTO system just click on the ‘Home’ tab (top left of the
screen in lllustration 1) and this will take you to the home page of the Filestore, from here you need
to click on the bright blue ALTO logo (see) to take you back to the homepage of the wider ALTO
system.

Browsing

At the start of this guide we stated that the Filestore software system operates using a digital library
metaphor, this becomes clear in the way that it allows users to browse through the online content.
When you click the ‘Browse’ tab at the top left of the page you will be presented with a page like
that in lllustration 3 that give a choice of three ways to browse through content of the Filestore.

By Year
Browse by Year Clicking on this option will display a |ISTC of the years
Please select a value to browse from the listbelow.  that the Filestore has records for (the image to the
right is an example). The figured in brackets indicate

‘ (21\ the numbers of resources that have been deposited in
(54) the system for that year. If you click on a year the
UNSPECIFIED resources deposited in that year will be displayed,
lllustration 2 shows what browsing for the year
Authors: The ALTO Project at the University of the Arts London. 6
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showed in early 2012.

By Author

Clicking on this option will display an alphabetical list of authors who have had their resources
deposited in the system, as shown below. The figured in brackets indicate the numbers of resources
that are associated with each author. If you click on an author the resources associated with that

author will be displayed.
D...

By Tags

Clicking on this option will display an alphabetical list of tags that have been associated with
resources deposited in the system, as shown below. The figured in brackets indicate the numbers of
resources that are associated with each tag. If you click on a tag the resources associated with that
tag will be displayed.

A..

Help

Clicking on the ‘Help’ tab at the top of the page will take you to a help page that provides
information and guidance about a wide range of issues concerning use of the wider ALTO system,
including links to this manual. If you have any specific questions about the Filestore or other parts of
the ALTO system, or spot any bus or errors you can email us at this email address alto@arts.ac.uk.

Legal Issues and Preserving Your Digital Resources

For UAL members of staff and students, your use of the Filestore and the other parts of the ALTO
system is governed by the Terms and Conditions (see http://alto.arts.ac.uk/filestore/terms.html)
and this is linked UAL policy as well as UK law — you should read these before using the system. For
members of the general public these Terms and Conditions also apply. There is also a ‘Notice and
Takedown’ policy (see http://alto.arts.ac.uk/filestore/notice.html), which provides a means for
people to complain about any content in the Filestore.

You should note, that while the UAL intends the Filestore and ALTO to be part of a growing
long-term service, the Terms and Conditions make no guarantee of indefinite provision.
Therefore, if you have digital resources that are valuable to you it is best to regard the Filestore
as on part of your own personal digital preservation strategy.
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Filestore Guide for Logged in Users
This part of the Filestore guide assumes you have already read the guide for non-logged in users, if
you have not done so you should do so now.

Logging in and Getting Started

The homepage for the Filestore is at this web address http://alto.arts.ac.uk/filestore/, from here
you can search for and browse through the content without logging in. The login link is at the top
right of the Filestore home page (see illustration 1). When you click on the login link you will be
presented with a dialogue box that asks for your UAL username and password. After you have
entered your information and clicked you are taken to your own personal profile homepage see
illustration 6, notice that a new set of menu items have appeared at the top right of the page -
these are only available to you once you have logged in and will stay visible as long as you are
logged in (see illustration 4 for a logged in view of the Filestore Homepage).

Setting up Your Profile

When you get to your profile page it is a good idea to enter your personal information (Click on the
Modify Profile there and make it public as this will act as your personal profile to users of the
system and helps them find out about you, your work and your interests. You can do this by clicking
on the ‘Modify profile’ button on your profile page. You will then be presented with an online form
list of fields to complete, the fields with white and orange stars next to them are mandatory.

Ignore the password field (the system will automatically use your UAL user password). For
‘Organisation’ put the UAL college or service that you work in and for Department enter the name
of the unit or department where you work. It is best to fill in the optional fields as well so people
can a well-rounded view of you and your activities and background. Once you have filled in your
profile information click on the save button and you will see how your profile looks. Next you can
select and upload a picture of yourself (or any image you choose to represent you) by clicking on
the ‘Profile Picture’ button.

We will return to explaining the use of the ‘Saved Search’ button later in this guide.

After you have saved your profile you will notice 2 sets of popup menus and buttons at the bottom
of your page. The buttons have the words the ‘Add widget’ and ‘Remove widget’ we recommend
you add all the widgets (a widget is just a tool that displays a selected type of content from
elsewhere on a page in a ‘window’ of its own:

* My News Feed — this displays any comments other users have left in the system about any of
your resources

* Quick Upload — this allows you upload a resource quickly from your profile page

* |R Stats Download Graph — this displays how many of your files have been downloaded over
time

* |RStats Top Ten —shows the ten most viewed of the resources you have deposited

* Latest Additions — this shows what resources you have recently uploaded

* My Bookmarks — shows what resources you have made bookmarks for

Authors: The ALTO Project at the University of the Arts London. 8
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* My Tag Cloud- shows the tags that are in use across the Filestore — clicking on one will
display all the resources that share that tag
* My Collections

You can see what a public profile page looks like with some of these widget enabled in Illustration
5, in the profile manager view you can drag and drop the different widgets to different positions on
the page.

In this section we shall step you through the procedure of creating resources in the system. It helps
to remember when learning to do this that Filestore is a digital library system that relies on
information you enter into the central catalogue (metadata). You need to be logged in to do this,
you have two options; a) use the ‘Quick Upload’ link on your Personal Profile page (if you have
enabled the ‘Quick Upload’ widget or b) click on the ‘Share manager’ link in the menu items at the
top right of the page. Both work in essentially the same way. These instructions assume you have
clicked on the ‘Share manager’ link.

When you have clicked on the ‘Share Manager’ link you will see a page similar to that shown in
lllustration 7. From here and the subsequent connected pages you can upload and control your
resources and the catalogue (or metadata) information you create about them. You also control
under what legal terms you are sharing these resources (via the use of licences) and who you are
sharing these resources with. These set of pages are like the ‘dashboard’ of a car from where you
can control what is going on with your resources.

After clicking on the on the ‘Share manager’ link you will see a page with 3 buttons across the top
called ‘New Share’, New Collection, Bulk Upload (see illustration 7). Underneath these buttons you
will see two tabs called ‘Resource’ and ‘Collection’, by default the contents of the Resource tab are
visible, we shall discuss the Collection function later in this guide. Under the Resource tab you will
also see a list of any previous resources you have uploaded, this area also acts as a ‘holding bay’ for
any resources you are working on but have not released yet — if you start creating a resource the
system will remember it and hold it here for you to finish.

The tool symbols shown here appear to the right of each resource you

have listed in your Share Manager and are. Here is a summary of what 4 v & R

these tools do: The green arrow icon provides a drop-down summary

about a resource. The magnifying glass icon take you to the actual resource, if it has ben deposited
in the system. The pencil icon take you to the catalogue record for a resource and allows you to edit
it, add new files or delete them and change the viewing permissions. The red-cross icon allows you
to delete a resource completely for the system — you will get a warning, asking you if you really
want to do this.

To create a new Resource click on the ‘New Share’ button, this will create a page as shown in
illustration 8. For simplicity, this guide assumes you have clicked on the ‘File’ tab. One important
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concept to get over at the start of this section is that a resource can contain a number of files, links
and even zip files. So, a resource in this system is not restricted to containing just one file —although
many people use it in that way. It is best to think of a resource as ‘place holder’ in the system that
can contain anything and it is the information about the resource that the system needs from you in
order to help manage and share your resources. lllustration 9 shows a resource that contains 3
different types of content

When you are working on this page it helps to remember that this system is at heart a digital library
and needs catalogue information from you (metadata) in order to work, which is why there are all
these fields to fill in —don’t worry only a few are compulsory! At the top of the page under the
heading of ‘Files & links” are 3 tabs with the titles of ‘File’, ‘Link’ and ‘Zip File’. These refer to the
type of things you can upload into a resource and clicking on one of these tabs will present you with
different upload options. Basically the ‘File’ tab is for uploading single files one at a time (NB you
can upload more than one file to include into a resource - see below). The ‘Link’ tab allows you to
create a ‘virtual’ resource in the system based on the web address that points to an external web
site — this could be a page at a museum or another open educational site. The ‘Zip’ tab allows you to
upload a group files all at once to create a new resource — to save time over uploading files one at a
time.

When you upload a new file, create a web link or upload a zip file the system will prompt you to
give a name to the new item, although not mandatory, it is a good idea to get in the habit of
doing this.

Mandatory — you need to give the resource a title and a description, you also need to name the
creator(s) / author(s) of the contents in the resource. A very handy feature of the system is that it is
linked to the UAL staff directory and as you start to enter someone’s name you will be presented
with a list of people to choose from to speed up the process.

Mandatory — you must choose a copyright licence for your work from the list. We recommend that
you consult the ALTO help pages to find out more about the legal aspects of sharing. The licence
choice you make here interacts with the ‘Viewing Permissions’ controls (see below and illustration
10) in the following ways:

* Ifyou chose a Creative Commons Licence you must select ‘Open to the World’

¢ Ifyou choose a ‘UAL Commons’ Licence your must select ‘UAL Only’
If you choose wrongly, the system will not let you progress until you have made the right selection.

Tags are a way of associating your resource with ideas and concepts and subjects, they are used
extensively in many online services as a way for users to organize and add meaning to their content.
If you create a set of tags the system will remember them for you and you can easily add them to
other resources. For instance, if you work in ceramics would probably want to use the word
‘ceramics’ as a tag.

Authors: The ALTO Project at the University of the Arts London. 10
Licence: This information sheet is made available under a Creative Commons Attribution 3.0 Unported License




. . Web: http://alto.arts.ac.uk/
alto - ALTO Filestore User Guide vi3o/1/12 Erail llogans ok

Mandatory — you need to choose who you want to share your resource with (see illustration 9). If
you chose ‘Selected Users’ then the system automatically restricts viewing just to you and any other
users you select. Your other choices are ‘UAL Only’ (so that only logged in staff and students can
view the resource) or ‘Open to the World’ (where the resource is visible on the open web). Note if
you choose ‘UAL Only’ you are given the extra option to restrict viewing only to members of staff.

If you change the viewing permissions for a resource in such a way that it contradicts the existing
copyright licence then the system will force you to make a choice to remove the contradiction.
lllustration 10 shows a user’s Share Manager with 3 different resources each having one of the
available viewing permissions. Note, the catalogue information (metadata) is public even for closed
resources but a user who is not logged in or who does not have the right personal permissions
granted by the depositor will either be required to login before they can view the resource or
refused access.

This is a nice feature if you are working in a team and want to allow other people to edit the
resource information and controls. This would be particularly useful if you are working on a project
where one (or more) people are given the role of creating detailed catalogue (metadata)
information about resources.

This section is likely to appeal to specialists and people who want to access specialised information.
When you are editing a resource that has already been saved successfully you will notice that the
resource name at the top left of the page changes to a light blue to indicate that it is an active link.
If you click on this link you will be taken to a page like that shown in illustration 11, it open by
default in the ‘Details’ tab to show the information that the system holds about the resource. The
light blue sections of text are links that if clicked on will take you to the related part of the resource
edit page in order to change them, if you want to return to the edit page just click on the ‘Edit Item’
button at the top right of the page.

You will see 3 other tabs to the right of the ‘Details’ tab; here is a summary of the functions
associated with each:
* Actions — allows you to do a number of useful tasks including; make a copy, create a
template, view the resource as it will be seen by others
* Export —this allows you to choose from a range of standard formats to export the catalogue
information (metadata) about the resource. You will be presented with a web page that
contains the information formatted according to the standard chosen —from here you can
copy and paste the information into whatever application you choose
* History — this displays (in machine readable format) all the changes that system has recorded
as a result of the activities of the resource owner(s)

lllustration 12 shows the ‘Training Resource’ as seen by a logged in user who created the resource.
If you compare this to lllustration 1A, which shows the display of the resource to a non-logged in
user then you will see the see that the differences are as follows:
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* More options in the Toolbox section
o Edit Item (Allows you to edit the Resource page) —if you are the resource owner
o Bookmark
o Use as Template (to create another resource record in the system)
* Comments and Notes are enabled
If a logged in user views a resource they have not created then the view will be the same as shown
in illustration 12 but with only 2 options available in the Toolbox section:
* Bookmark
* Download as zip

To create a new virtual collection of resources from the Filestore you must go to the ‘Share
Manager’ - which can be accessed from the Filestore logged in user menu links at the top right of
the page (see illustration 4) and select the ‘New Collection’ tab (see illustration 7). This will result in
a new page being displayed that allows you to create a collection (see illustration 13). This is similar
to the new resource page shown in illustration 8. The mandatory catalogue (metadata) items are
Title / Descriptions and Viewing Permissions. A quick note on viewing permissions is useful here —to
be included in a collection a resource must be either shared with the world or with the UAL, if a
resource is not shared with either of these categories it will not be included in a collection.

To add resources to a collection you have two options:

1. Use the 3 tabs at the bottom of the page — Search / My Deposits / My Bookmarks — to find
and select resources (illustration 13). Click on the checkboxes of the resources you want to
include and then click on ‘Save’. Note, you might have to repeat this process, as each time
you click on Save the system by default returns you to the Share Manager. (NB there is a
know bug in the system at 30/1/12 which makes these options no-operational — we hope to
have it fixed soon, until then the second method of creating a collection as described below
does work)

2. In the Share Manager click on the Resource tab and select the resources you want to add to
a collection by clicking on their checkboxes and then select ‘Add to Collection’ from the pop
up menu — as shown in illustration 14.

Once you have selected the resources for a collection (in step two above) you will be presented
with a page like that shown in illustration 15 which displays the resources you have selected and
gives you the option to either create a new collection to house your resources or add them to an
existing collection chosen from the popup list at the bottom of the page. For this example we have
chosen to add the selected resources to an existing collection called ‘Training Collection’. Once you
have done this the display changes back to the Share Manager and you see a notification that the
changes have been saved.

To view your new collection click on the Collection tab in the Share Manager and you will see a page
like that shown in illustration 16. To view the contents of a collection you just have to click on its
title, wherever it appears (in the Share Manager, or in a Browse, or Search) and you will see a page
like that shown in illustration 17 (for a logged in user who ‘owns’ the collection). Notice that this

collection is made up of resources some of which contain more than one file and different viewing

Authors: The ALTO Project at the University of the Arts London. 12
Licence: This information sheet is made available under a Creative Commons Attribution 3.0 Unported License




. . Web: http://alto.arts.ac.uk/
alto - ALTO Filestore User Guide vi3o/1/12 Erail llogans ok

permissions, also notice that the Toolbox section of the display does not have a download option —
each resource has to be downloaded separately.

When you browse or search, a collection is indicated by the use of a yellow folder icon as shown in
illustration 18.

Making Bookmarks

You can bookmark resources in the Filestore just like you can in a web browser. To do this you
simply click on the ‘Bookmark this item’ link in the Toolbox section of the resource display and the
resource will be added to your personal bookmarks list — which can be accessed from the Filestore
logged in user menu links at the top right of the page (see illustration 4).

Saved Searches

A neat feature of the Filestore is the ability to save a search. At first you might think this is not that
useful but it provides some potentially powerful functions. You can save a search by clicking on the
Save Search menu option as shown in illustration 18. When you do this you will be presented with a
display like that shown in illustration 19. You will see that you have the option for the search to be
automatically repeated at regular intervals and for an email of the results to be sent to you — this
could be useful of you were keeping a watch on a large collection for certain topics being added.
You also have the option to make a Save Search public, what this means is that you can share the
web address of the page that displays when you click on one of your public searches in you. To
access your Saved Searches click on the Saved Searches menu as shown in illustration 20. The
searches with blue titles are public, if you click on one of these it will display a web page of results
with a web address that you can copy and share with other people — you can send a colleague a
search link via email, another option is to embed the search in another web site such as a blog etc.
The page shown in illustration 20 also allows you to edit and delete your Saved Searches.

Reporting Bugs and Issues
If you discover any bugs or would like changes or enhancements to the system please let us know
by emailing alto@arts.ac.uk

Known Bugs and Issues

Jan 30" 2012
Here is a link to the latest working list of bugs and issues http://alto.arts.ac.uk/912/
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